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1. INTRODUCTION 

The Telog Water Level Logger (Telog logger; logger) is a continuous water level logger that can 
be used for continuous monitoring of aquifer level at groundwater sites. The Standard 
Operating Procedures (SOP) for the Telog Water Level Logger should be followed any time the 
Telog logger is used. This document describes the standard operating procedures and best 
practices for using the Telog logger, including calibration, quality assurance and quality control 
(QA/QC) activities, troubleshooting, logger setup and data download, and maintenance 
activities. This document is to be used in conjunction with the relevant project Quality 
Assurance Project Plan (QAPP; LWRD 2018a) and the Telog R-2100e Series Recorders Hardware 
and Installation Manual (Telog 1995) and Telogers for Windows User Guide for Version 2 (Telog 
1999). 

1.1 Method Summary 
Telog loggers are programmed prior to deployment in the field to specify water level 
measurement recording interval, to correct the scaling of the logger, and to convert to desired 
user units. Telog loggers are calibrated annually, and field QA/QC checks and maintenance 
activities occur on a frequency determined by the recording interval. Field QA/QC checks 
include zero water level accuracy checks. Maintenance activities include checking and changing 
batteries, desiccant packs, and vent filters. 

1.2 Health and Safety Warnings 
No water quality measurement is worth risking injury or death. Field personnel must be aware 
of the environment, use common sense and training, and not exceed their abilities or limits. 
Field work is never conducted alone. All Lummi Natural Resources (LNR) Water Resources 
Division (LWRD) Health and Safety Plan (LWRD 2015) requirements and guidelines are followed 
at all times while conducting fieldwork. 

1.3 Quality Assurance/Quality Control (QA/QC) 
Quality assurance/quality control activities are integral to logger maintenance and provide 
information to the sampler and analyst about logger condition and data reliability. The QA/QC 
activities for assessment of logger operation occur before loggers are deployed and during field 
visits. Logger problems or failure to meet QA/QC activity acceptance criteria initiates corrective 
actions.   

The sampler can take corrective actions based on the results of QA/QC activities to ensure that 
measurements have a known accuracy, precision, and traceability. All problems, corrective 
actions, outcomes, and resolution are documented in Water Database or on field datasheet 
(LWRD 2018b,c).  
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2. INSTRUMENT PREPARATION FOR USE 

The Telog loggers consist of two parts: the pressure sensor and the recorder. As a unit, the 
pressure sensor must be deployed and the logger must be set up to log measurements at 
project-specified intervals and to convert measured units to transmitted units to user units (i.e., 
adjusting the scaling). Scaling adjustment allows for reporting of units as required in the 
relevant project QAPP. 

2.1 Logger Setup 
Prior to deployment, the Telog logger is programmed to record measurements every hour and 
to display units as feet of water. 

1. Connect the logger to the field computer using the serial port connector 

2. Open Telogers for Windows 

3. Setup > Modify > Select the name of the recorder 

o The Recorder ID is the serial number of the recorder 

o Recorder Name is specified in the project QAPP 

o Recording interval is specified in the project QAPP 

o Sample rate is specified in the project QAPP 

o Excitation delay is 15 milliseconds 

o Range should show 0 – maximum mAmps depending on the type of sensor 

o Enable Min Avg Max cutoff 

4. Under Scaling: 

o Channel Scaling tab 

o Shows mAmp output of the sensor 

o User Units are ft H2O 

o Displayed Format is #,##0.0# 

o Channel Point #1 is lowest mAmp output (e.g., 4 for 4-20 mAmp transmitter and 
10 psi pressure sensor) 

o User units point #1 is 0 

o Channel Point #2 is the highest mAmp output (e.g., 20 for 4-20 mAmp 
transmitter and 10 psi pressure sensor) 

o User units point #2 is the scaling unit specified in the manual (e.g., 23.067 for 4-
20 mAmp transmitter and 10 psi pressure sensor) 

o Press OK to update changes 
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5. Press Program to save programming changes 

2.2 Scaling 
Water level is measured by a pressure sensor that sends an electrical signal to the recorder. The 
pressure sensors can have varying pressure ranges with the maximum psi listed on the sensor 
itself, usually 10 or 20 psi. The sensor sends an electrical signal through the transmitter to the 
recorder, which is rated as a 0-20 or 4-20 mA transmitter. The pressure sensor measures the 
pressure of water present above the sensor as a percentage of its maximum pressure range, 
and translates this to a related percentage of the transmission range. Finally, the recorder can 
be set up to show the measurement in feet of water above the sensor by using a scaling unit 
that converts the pressure in psi to feet H2O. Table 2.1 summarizes the scaling conversion for 
Telog loggers from pressure to voltage to water level (feet H2O). 

 
Table 2.1  Scaling Conversion for Telog Water Level Loggers 

Pressure (psi) Voltage (mAmps) Water Level (feet H2O) 

0 Minimum voltage  0 

Pressure rating of sensor Maximum voltage 
Scaling chart (depends on psi) on 

(Telog 1995, page 25) 
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3. INSTRUMENT USE IN THE FIELD 

Telog loggers are designed for data to be downloaded in the field without removing the 
pressure sensor from the groundwater well. As the loggers continue to measure water level (as 
pressure converted to feet H2O above the logger), instantaneous water level can be viewed 
using Telogers for Windows software on a field laptop.  

3.1 Data Download 
Detailed instructions for downloading data from the Telog logger follows: 

1. Check that the date/time on the field laptop are correct. Note: time is Pacific Standard 
Time. Do not adjust time to reflect daylight savings time; adjustment will result in 
logger-field laptop time discrepancy twice per year.  

2. Connect field laptop to data logger using the serial port connector 

3. Open Telogers for Windows 

4. Select Communicate > With Local Recorder > Collect Data > Start 

5. A window will appear to download the data from the recorder 

6. File > Analyze Data From Database > Select Data to Analyze 

7. Select the appropriate groundwater well and click OK 

8. Scroll down in the window to the right to view the last data point recorded before the 
download. The logger collects a reading every hour; therefore, the last data point 
recorded should be an hour or less prior to the site visit time. 

3.2 Instantaneous Water Level 
When the logger is connected to a field laptop, instantaneous water level readings can be 
viewed using Telogers for Windows. The steps below provide the details for viewing 
instantaneous water level: 

1. Connect field laptop to data logger using the serial port connector 

2. Open Telogers for Windows 

3.  Select Communicate > With Local Recorder > Display Latest Readings > Start 

4. The instantaneous water levels will be displayed on the screen 

3.3 Saving Data Files 
Data files can be saved as .CSV files on a local or network server.  

1. Open Telogers for Windows on the field laptop 

2. Select the “Db” icon in the Telog software 
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3. An “Analyze Dataset from Database” window will appear 

4. Under the “Select Data to Analyze” tab, select a logger (typically identified by the name 
of the well in which it is deployed) by checking the box next to the selected logger 

5. Select Dataset Properties 

6. In the Select Start Date menu, identify and click to highlight the selected start date of 
the data range to save. Alternatively, the check-box can be selected to “Set to oldest 
data available.” 

7. In the Select Stop Date menu, identify and click to highlight the selected end date of the 
data range to save. Alternatively, the check-box can be selected to “Set to oldest data 
available.” on the right of the display screen, make sure the check-box next to “Set to 
most recent data available” is selected (this will ensure you have included and backed 
up the most recent data that has been downloaded). 

8. Click OK 

9. This should bring you to a display page with a graph of well results and a spreadsheet of 
data. Scroll down the spreadsheet to get the date of the last data point collected – this 
date will be used later to organize and name files. 

10. File > Save Data Set As… 

o A window with a menu to save the current data set will appear 

o File location and file naming conventions are specified in the project QAPP 
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4. QUALITY ASSURANCE/QUALITY CONTROL (QA/QC) 

4.1 Calibration 
Telog loggers are calibrated by the manufacturer when accuracy check acceptance criteria are 
not met (Mayoue 2016 pers comm). The manufacturer does not recommend calibration by the 
instrument user (i.e., LNR staff) because of the difficulty of generating a steady, accurate 
pressure to the sensor during calibration (Paine 2016 pers comm). 

In the event that the manufacturer determines that a particular logger can hold calibration and 
does not require recalibration on an annual basis, the manufacturer calibration frequency can 
be extended to two years. In this case, zero accuracy checks are conducted annually to ensure 
that loggers have known and acceptable accuracy, bias, and precision. 

4.2 Accuracy Checks 
Proper function of the Telog loggers can be checked by conducting accuracy checks.  

4.2.1 Paired Readings 

Paired readings of the logger and an independent water level measuring instrument (e.g., 
Waterline Envirotech 500-ft electric tape with engineering scale) can be used to:  

1. Confirm the deployment location of the logger  

2. Allow conversion of units from feet of water above the logger to feet of water below a 
determined measuring point 

3. Track calibration drift over the duration of the deployment 

Frequency and procedures for conducting paired readings depend on the project. Details for 
conducting paired readings and acceptance criteria are provided in the relevant project QAPP.  

4.2.2 Zero Accuracy Check 

A zero accuracy check is conducted by viewing the instantaneous readings from the logger in 
air. If functioning properly, when the logger is removed from the well and held in the air (i.e., 
not under water), the instantaneous readings should show zero. See Section 3.2 for instructions 
for viewing instantaneous readings. Refer to relevant project QAPP for details on acceptance 
criteria for the zero accuracy check, as limit depends on data use.  
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5. TROUBLESHOOTING 

For all troubleshooting activities, document observations, corrective actions, and outcomes in 
Water Database or on field datasheets, as specified by the relevant project QAPP. The sections 
below provide steps to be taken to identify and remedy equipment problems as they arise 
during performance of QA/QC activities and data download in the field. Troubleshooting for 
logger deployment is site specific and not covered in this SOP, see relevant project QAPP for 
details. 

5.1 Data Download Issues 
For problems downloading data from the Telog logger, attempt the following corrective 
actions: 

1. Ensure that the serial port connector is securely connected to both the field laptop and 
the recorder. 

2. Ensure that the field laptop recognizes that the recorder is connected. Make sure that 
the recorder is connected before opening Telogers for Windows. 

3. Local port must be activated in order for the computer to recognize the recorder. In 
Telogers for Windows go to Setup > Options. Select the Communications tab, and turn 
on “Enable Local Comm” and select the appropriate Local port. The Local port (i.e., USB 
drive) into which the recorder is plugged in should automatically show up in the list. 

4. If data still cannot be downloaded, attempt to view the logger activity in instantaneous 
water level mode (Section 3.2).  

o If instantaneous water level does not show, the logger may not be properly 
connected to the computer, or the battery charge is too low. 

o If instantaneous water level shows, re-attempt data download. If data still 
cannot be downloaded, the battery charge may be too low to transmit data. 

5. If the computer cannot connect to the recorder, there may be a problem with the serial 
connector. Check communication from the communication port on the computer to the 
end of the serial connector as follows. 

o Disconnect the serial port from the recorder. 

o With the serial port oriented with the five prongs on top (four prongs on 
bottom), connect the second and third prongs from the left on the top (five 
prongs) with a metal paper clip. 

o Open Telogers for Windows. 

o Select Communicate > With Local Recorder > Collect Data > Start. 

o At the bottom of the Telogers screen, monitor the text. If communication was 
sent from the computer to the end of the serial port (with the paper clip) and 
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back to the computer, a logger will be identified. If there is no change in the text, 
there is a problem with the cable. 

o Contact Telog technical support for assistance with cable problems. 

6. Check the battery charge. If the battery charge is log, change the battery (Section 7.1). 
Re-attempt data download.  

o If data still cannot be downloaded, the data may have been lost due to slow 
battery charge or damage to the logger 

o Check deployment settings and view instantaneous water level mode (Section 
3.2) to ensure that the logger is able to measure water levels 

7. If damage to the recorder is suspected (i.e., because logger will not show instantaneous 
water level measurements even after battery change), remove Telog logger from the 
well and contact manufacturer for further guidance. 

5.2 Accuracy Check Issues 
If accuracy checks do not meet acceptance criteria, attempt the corrective actions outlined in 
the relevant project QAPP. General corrective actions for Telog loggers follow: 

1. Repeat accuracy check using best practices 

2. Check the scaling in the deployment settings (Sections 2.1 and 2.2) 

3. Clean pressure sensor gently to ensure that dirt has not become lodged in the pressure 
sensor. See Section 7 for cleaning instructions 

4. Remove Telog logger from the well and contact manufacturer for further guidance 
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6. INSTRUMENT SPECIFICATIONS 

Table 6.1 lists the instrument specifications for the Telog water level loggers and recorders.  

 
Table 6.1  Range, Accuracy, and Resolution for WLS-2102e Level Trackers and R-2102e Recorders 

Component Range Accuracy Resolution 

R-2102e Recorder 
0-20 or 4-20 mA 

transmitter 

±0.15% of sensor full 
scale at constant 

temperature; 

±0.01% of sensor full 
scale per °C change 

5 µA (0.005 mA) 

WLS 2102e Level 
Tracker (sensor) 

1, 2.5, 5, 10, 15, 20, 30, 
50, or 100 psi 

±0.1% None Specified 

Full System 
Depends on recorder 

and sensor combination 

±0.25% of sensor full 
scale at constant 

temperature 
0.01 feet 

 

The accuracy of the full system, in feet of water, depends on the water level measurement and 
psi rating of the sensor. For a 10 psi sensor at its maximum range (23.067 feet water), the 
accuracy is 0.058 feet. For a 20 psi sensor at its maximum range (46.133 feet water), the 
accuracy is 0.115 feet.  

Accuracy acceptance criteria for Telog loggers depend on project goals and are specified in the 
relevant project QAPP. 
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7. MAINTENANCE 

Maintenance activities include battery and desiccant replacement, and vent filter and pressure 
sensor cleaning. Details are provided in the Telog R-2100e Series Hardware Manual (Telog 
1995). 

7.1 Battery Replacement 
A 14-Vdc lithium battery pack is located on the inside of the recorder cover. Battery pack 
voltage is tested during each field visit using a digital multimeter set to 20 V. Batteries are 
replaced when the pack voltage is below 13.5 Vdc. The battery packs must be changed within 
20 seconds to avoid loss of memory and programmed settings. The battery pack is attached to 
the cover with a Velcro strip and to the circuit board by two wires and a connector. The 
connectors are color-coded to assure proper polarity and installation. Used battery packs can 
be discarded in the garbage, or recycled if appropriate facilities are available. Additional details 
on battery replacement are provided in the Telog R-2100e Series Hardware Manual (Telog 
1995; pages 30-31). 

7.2 Desiccant Pack Replacement 
A desiccant pack is attached to the inside of the recorder cover with a Velcro strip, adjacent to 
the battery pack. The desiccant pack plays a vital role in limiting moisture inside the recorder 
enclosure; excess moisture can impede proper sensor operation and result in recording of 
inaccurate data. The desiccant packs are checked during each field visit by inspecting the color 
of the internal desiccant material. When fresh, the desiccant is a very dark blue; when moisture 
has been absorbed by the desiccant, the material will turn light pink. When the desiccant turns 
light pink, the pack needs to be replaced with a fresh one. 

The desiccant packs can be regenerated by baking at 300°F (150°C) in a vented oven for 
approximately three hours, or until the blue color returns. Old Velcro strip and any adhesive 
should be removed before baking. A new Velcro strip is attached after the desiccant pack has 
been regenerated and allowed to cool. Regenerated desiccant packs are stored in double-
bagged ziplock bags. 

7.3 Pressure Sensor 
The pressure sensor is rinsed gently on an as-needed basis. Remove the plastic bottom tip of 
the pressure sensor and remove the screen. Rinse the pressure sensor gently with distilled 
water to remove any dirt that may have become lodged in the sensor. The plastic tip and screen 
can also be cleaned. Do not probe the pressure sensor with any solid object (such as a Q-tip) to 
remove debris as the pressure sensor can become punctured. If debris is visible, but cannot be 
removed with water by rinsing, return the pressure sensor to the manufacturer for proper 
cleaning. 
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7.4 Vent Filter  
The vent filter is located on the side of the recorder and vents the enclosure interior to the 
atmosphere, eliminating the effects of atmospheric pressure changes on readings. During field 
visits, the vent filter is checked to ensure that it is not blocked by debris. A small brush is used 
to remove grit or grime that may be blocking the filter. If the filter becomes clogged and cannot 
be cleaned, it can be replaced with a spare or a vent filter from a recorder that is not currently 
in use. Details on vent filter replacement are provided on pages 36-37 of the Telog R-2100e 
Series Hardware Manual (Telog 1995). Replacement vent filters are no longer available from the 
manufacturer; if the vent filter is completely clogged and no other vent filters are available, 
contact the manufacturer. 
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8. ACRONYMS AND ABBREVIATIONS 

LIBC  Lummi Indian Business Council 

LNR  Lummi Natural Resources 

LWRD  Lummi Water Resources Division 

QAPP  Quality Assurance Project Plan 

QA/QC  Quality Assurance/Quality Control 

SOP  Standard Operating Procedure 
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